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Medication Reviews - Newfoundland
and Labrador

This document outlines how to configure Medication Review functionality in Kroll and the
process of completing Medication Reviews for both paper based and electronic records.

Configuration

This section explains the configuration settings that must be in place before attempting to use
the Medication Review functionality.

Configuring Electronic Signatures

NOTE: Only complete this section if you are using Electronic Signature pads.

Before you can begin configuring electronic signatures, Allow Electronic Signatures must be
enabled in File > Configuration > Kroll > Configuration. This will require a support call and must
be completed before proceeding.

o Kroll Configuration Parameters |E|[i_hJ
General Qunfigurati0n| Modulesl IherapeuticAdvisurl §tati0n| Lugging|

I Allow Electronic Signatures I Faollow Prowincial Legislative Fules for Fx Transfer
[] Enable SetLaser labels
[C] Allow NDC

1. Go to File > Configuration > Store > General.

2. Place a checkmark next to Allow Electronic Signatures.

w Store Level Configuration Parameaters E 2
General F'atientl Dug I Doctorl Fix | FDE | .&diudicationl Labelsl Heportsl Securit_l,ll Interfacesl Dldell ><-.-’-‘«HI ¥ -To Do| ECtrl E)
Allgws User Calars ) ) [ Alvways Show Scan [ Display ‘Window 'When Services are Dawn
?Iloglﬂﬂ:m;bﬁfn:guratmn Frompt to exit when clozing fill applization |Jge automatic capitalization
e - Use Unit Dose Packaging | 2] Allow Electioric Signatures |
Default language | English J Default area code Enable Ctrl-PrintScreen to Print Screenshot
Default Country Canada ﬂ Sort Bx Transfer Stores By Store Mame j

Store Information

3. Click OK to save the changes.
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Configuring Electronic Medication Reviews

1. Go to File > Configuration > Store > Rx > Counseling > Med Reviews/Dialogs.

w’ Store Level Configuration Parameters E =

| Generall F'atientl Drug I Doctorl Rz I FDB I .-’-‘«diudicationl Labelsl Heportsl Securityl Intelfacesl Drderl ><-AF|| Y- Ta Do| [ECtrl @
| ‘I-Generall 2-F'ricing| 3-Prompting| 4 - Mursing Homel 5 - Background Fx FiIIingI B-Workflowl ?'CDUHSEHHQI 8-EeFI:-:|

R Caunzeling Autarnatic Patient Counzeling
Allow editing counseling time On Mew R
Require Electronic Signature Only flag if patient hazn't had the drug inthe last 180 days
Uszers Permitted to Finalize Accepted Counseling [C] Or Refils
Fharmacist Licersed Technician [] On Drug Changes
Pharmacist Intern Pharmacy Tech Student Allows Uger bo Turn OFF Automatic Coungeling for an Bx
Fharmacy Student Pharmacy LAssiztant
IT Suppart

Yizible Tabs
Hardcopy T ab RxImages Tab
RxTab “wiorkflow Tab
Financial Tab Packaging Tab

Med Reviews/Dialogs

Reguire Document Scan to Complete Paper Med Review
Enable Electronic Med Reviews

Fequire Electronic Signature

Allow Editing Caunzeling Time

T

2. Inthe Med Reviews/Dialogs area above, ensure the following options are set appropriately.

e Require Document Scan to Complete Paper Med Review: this option allows you to
complete paper-based Medication Review using the document scan functionality;

e Enable Electronic Med Reviews: enabling this option allows you to use the electronic
version of Medication Review;

e Require Electronic Signature: enabling this option prompts for electronic signatures
where necessary (only if you are using Electronic Signature pads).

e Allow Editing Counseling Time: this option allows you to modify the system-calculated
amount of time it took to complete the counseling session.

3. Click OK.
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NOTE: If you turn off the Require Electronic Signature option and keep the other options
enabled you will still be able to complete the reviews on-screen. However, you will need to
print the report, in order to capture pen-to-paper signatures and then scan it back into the
system before giving it to the patient.

Electronic Medication Reviews

This section explains how to perform an Electronic Medication Review. Ensure your system is
configured for Electronic Medication Reviews before proceeding. See Paper Medication Review
for information on the non-electronic process.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring the Medication Review Prompt

The system prompts for Medication Review when the option Prompt for Medication Review is
enabled under File > Configuration > Store > Rx > Prompting.

[ w’ Store Level Configuration Parameters |E| Ljﬁ ]
| ﬁenerall Eatientl Drug | Dgct0l| Bx | ECE | gdiudicationl Labelsl Heporﬁsl Eecurit_l,.ll lnterfacesl Drdgll K-AHI ¥ -To Do| [Ectrl E

1- Generall 2-Pricing] 3~ PleDlinQ| 4 - Nursing Homel 5 -Backgmound Rx FiIIingI B- Workflowl i- Eounselingl 8- Eth-c|
Diug Prograrns

Prampt ta use Drug Subs 7] Automaticaly use Dirug Subs [] Participate in the Rx Canada / Health Inform Program

Usze Dirug Subs when B atching

Prompt If Doctor Refuged Repeat 'When Cancelling Rix [ Participate in the Pharmacy Access proaram

Prompt for Comments when Canceling an Fix [ Use Station Mame Subdirectaries For Pharmacy Access
[ Ahways require comment Days Back: 365

[ Prompt for Comments when Inactivating an R [] Enable Rx Canada Frogram [RxGateway)

[T Always require comment

[ Prompt for Patient Counzelling on new R . . . . .
7] Prompt to Bateh NH Fies [] Prompt ta Enral Patients in Refil Feminder or Auta Refil Program
F ) ) ) ) Prompt to Enrol MH Patients in Refil Reminder or &uto Refil Program
Erompl ;\lheFr; not d'SE:ES'n%aS cllrug 5 PF‘?CR Size Prompt to Enable Rxs for Refill Reminder and Auta Refill Program
rompt For Fiepeats er_1 CRing an Fix § Enrol Patients for Pickup Motification Mo j
Prompt Ta Use Manual Price From Last Refill

Services

[7] Remove Manual Price for Batched Fixs Enrol MH Patierts for Fickup Notification No j

[] Prompt if Doctor Autharization Received for Narcatic Rxs

[] Check far High Intensity Drugs Prompt to copy workflow packaged info for cancel and refill Rxs
Prompt if there iz not enough inventany to fill the Ax Prampt to copy to nevs number if refiling an A= with no repeats

[] Prevent Copying an Inactive Rx to a Mew Mumber [ Prompt for Due Date on autofill batches

[] Show local patient profile on fill [ Prompt for T« comment on autofill batches

Frompt ta Copy "Mistake" Rixs to a New Number Save Routs cods from Rk a5 defaul valus if no defaul is set Ask |

[T Shaw thermal/dat matriz label config an autafil
Save Form eode from R ax default value if no default iz set Ak j
[ Prompt to Print Script Image for 1st Fill of an Unfiled R«
[ Prompt for &4DL Plan Information if Sé number is NOT set I Prompt for Medication Review I

] Track Medication Review Rejection Reazon:
Allows Mever Prompt’ For Medication Review

[] Prompt if waz Undeliverable when Canceling an Rix

Search " OK
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When the option ‘Prompt for Medication Review’ is enabled, the system screens each patient
for Medication Review eligibility every time an Rx is processed. If the patient is eligible, the user
is prompted and presented with a number of options as shown below.

wf Select an Option & RS

This patient may be eligible for the Prescription Drug Program.

| Add to Med Review Queue |

| Do not prompt me until the next time the patient comes in. |

| Do not prompt until ... |

| MNever Prompt for this patient |

| Undecided |

e Add to Med Review Queue: Selecting this option adds the Med Review record to the
Medication Reviews queue which can be accessed from the Patient record or
F9 — Workflow. See section ‘Completing MedsCheck ‘Saved for Later’ for further details.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

o Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.

e Undecided: The prompt will re-appear once again the next time a prescription is filled
for the patient.
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Creating an Electronic Medication Review (Manual)

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor l F9 - Workflow
Last Name Doe First Mame Jane Salutation Ms. j _ Save [l

F11 - Drop-off " F12 - New Rx " Alt-X - Start ]

Profil
Address1 100 Main St Phone Numbers (1) Bithdate 01/01/1980 it
Description |Phone | Al Rxs
Address 2 Age 34 years
J J Cell (555) 555-5555 J Active Rus
City 5t John's *| Prov NL = Gender Female b i il
Ne JanEtzlable Active Rxs w/Passtimes
Postal M1 1M Country Canada j Language English j
Refillable Rxs
Email Family Doctor Height . "
Pricing Profile
Quick Code Weight Load ][ Delete ] Not Dip./OTC R
ot Disp./ s
Comments (0) [0zl -
— (F2)m=te) ops J Rxs Filled in Error
Topic Comment
Plans (1) Suspended Rxs
| subPlan Code| Group I | Client 1D |Expiy | -
1 VET 11111 Perform FDB Analysis
View
Alternate Addresses
~ Batch
Allergies (0) (2] (Inz) (D=l General } Family l Copa}'ﬂ Comm!nifationsl Other l Ectrl B atches
- Charting
Patient Consent
MActive Consent Unknown Consent
Credit Cards
A |
nimal - [J Unit Dose D
Deceased On Type <None> j ocuments
Medical Conditions (0) [Tns) (Del] — Medication Review/Dialogs (15)
Prescriptions Cycle <Mones |
. Rx Ceunseling Histo
Delivery Type _ Default (Pickup) vl priceGroun  <Defanire (eNoneei ol J ¥

3. The Medication Review profile will appear. Click N — New Review/Dialog.

w# Patient - Helvey, Ricky * B|= =] K

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor F9 - Workflow

Last Name Helvey First Name Ricky Salutation j _ Save Patient
Profile
N - New Review/Dialog

F10 - Pickup “ F11 - Drop-off ” F12 - New Rx " Alt-X - Start

All Rxs
icati i Active Rx
Medication Reviews [0] ctive Rxs
Tupe Status Fee Status Created ¥ | Completed | Active Rxs w/Passtimes

Pricing Profile

‘ ‘ Refillable Rxs

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown
menu and click Perform Now. If you wish to add to the Med Review queue in order to
complete the Medication Review later, click Save for Later.

w° Medication Review/Dialog LEJ&

Type Prescription Drug Program j

I Perform uowl l Save for later ] l X cancel ]




Computer Systems Inc

\//5( KROLL Medication Reviews - Newfoundland and Labrador

5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the
Rxs you want included in the report. When you are finished, click OK.

w° Medication Review Rx Selection P E|=B] X
Pre-Selected (3) | Other Rxs | Unfills | Not Dispensed | Discontinued
Rx Mum Drug Fill Date
1000958 Amoxicillin 50/ml 11-Jul-2014
1000957 Prinivil 2.5mg 11-Jul-2014
1000956 Synthroid 112mcg 11-Jul-2014
Select All ] ’ Select None ]
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default j
v oK

6. The Prescription Drug Program screen will appear. Click Next to proceed through the tabs,
completing the required fields as you go.

NOTE: The type of review that is displayed on screen depends on what type of review was
selected in Step 4. In this example, the Prescription Drug Program screen appears.
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Questions

The Questions tab includes a list of questions that the pharmacist is to ask the patient to better
understand their situation. Answers are recorded by selecting the appropriate option from each
dropdown menu.

Questions IMedicaI History [ Mon-Prescription Medications | Rxs From Other Pharmacies | Pharmacist Activities l General Commer * | *

Alcohol Intake <Mot Answered> j

Physical Activity <Not Answered> j

Smoking <MNot Answered> j

Consent Given <Not Answered> = |

Type Diabetes Diagnosed <MNot Answered> j

Does the patient check his/her blood sugar on a regualr basis <MNot Answered> Ll

m

What was the Patient’s last known Blood Glucose
What was the Patient's last known Blood Pressure
What was the Patient’s last known HbAL1C

What was the Patient’s last known LDL-C

What was the Patient's last known TC/HDL-C

X save for Later © Next

Medical History

The Medical History tab displays the medications that have been selected on the Medication
Review Rx Selection screen.

| Questionsl Medical History I MNon-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

Patient Medical History Ins
Currently Taking 7 TAB Synthroid 112mcg [KNO] Indications
Yes j Pink Round Tab Flint 112

Dr. Moultrie, Filipe Comments
Last Fill Date: 14-Jul-2014, Days Supply: 7
TAKE 1 TABLET OMCE DAILY
Currently Taking 30 TAB Prinivil 2.5mg [MSD] Indications
Yes j Dr. Moultrie, Filipe
Last Fill Date: 14-Jul-2014, Days Supply: 30 Comments
TAKE 1 TABLET EVERY MORNING
Currently Taking 7 ML Amoxicillin 50/ml [SNS] Indications
Yes j Dr. Moultrie, Filipe
Last Fill Date: 14-Jul-2014, Days Supply: 7 Comments
TAKE 1 TEASPOOMN(SML)ONCE DAILY

X save for Later
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For each medication listed:

¢ Note if the patient is currently taking the specified medications and select Yes/No from
the dropdown list.

e Enter the reason for using the medication based on the patient’s feedback in the
Indications field.

e Enter any general comments in the Comments field.

Use the Del button to delete a record from the Medical History tab.

Non-Prescription Medications

The Non-Prescription Medications tab provides space to record any OTC/non-prescription
medications the patient is taking.

Click Ins to add a non-prescription medication to the tab.

Questions | Medical Historyl Non-Prescription Medications I Rxs From Other Pharmacies | General Comments | Pharmacist Comments

Non-Prescription Medications / Herbals / Supplements 1ns |[Del
Currently Taking  Claritin 10 mg For seasan allergies
Yes j

X save for Later @ Next

¢ Note if the patient is currently taking any OTC medications and select Yes/No from the
dropdown list.

e Enter the name of the medication in the Medication field.

e Enter any appropriate comments in the Comments field.

Use Del buttons to remove any OTC items.
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Rxs From Other Pharmacies

The Rxs From Other Pharmacies tab provides space to record medications that the patient is
taking that were filled in other pharmacies.

Click Ins to add an Rx from another pharmacy.

| Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

Prescriptions From Other Pharmacies

From - Smith's Pharmacy - (555) - 123-4567

Currently Taking  Tylenol # 3 - Take 1 to 2 tablets up to 4 times a
Possible duplication of therapy

Yes j day when needed for pain

From - Duncan Mill Pharmacy - (355) - 555- 5555

Currently Taking  gisoprolol 5mg - take 1 tablet daily
Duplication of therapy

Yes -

x Save for Later O Mext

Note if the patient is currently taking any other medications and select Yes/No from the

[ J
dropdown list.

e Enter the name of the medication in the Medication field.
e Enter any appropriate comments in the Comments field.

Repeat the same process for any Rx items that they have purchased from other pharmacies.
Use Del buttons to remove any Rx items.
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General Comments

The General Comments tab provides space to record any comments you want included on the
report printout.

| Questions | Medical History | Non-Preseription Medications | Rxs From Other Pharmacies | General Comments | pharmacist Comments |

Pharmacist Comments

© Next

The Pharmacist Comments tab provides space to record any comments that the pharmacist
wishes to enter concerning the medication or patient in the free form.

| Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments |

[ |
—— [ ]

7. When you are finished click Finalize Review.

10
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8. The Medication Review prompt will appear. If you have Allow Editing Counseling Time
enabled, enter the amount of time it took to complete the review in the Time spent field.

The Assessment Location information is pre-populated with the pharmacy information. If
the Medication Review was physically conducted in another location (LTC facility, patient’s
home) other than the pharmacy, enter the name of the location and the address. Complete
the Other Professional Involved fields if another health professional assisted with the

review.

When you are finished, click OK.

wf Medication Review = 2

Time spent: 00:30 On 14/07/2014 By Pharmacist (P) j

Assessment Location
Mame Kroll Pharmacy
Address 220 Duncan Mill Road, Suite 201, Toronto, ON M3E 3J5

Other Professional Involved

Mame T
Title Technician

Phaone

| ok | | XCanceI|

11
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Affixing an Electronic Signature

NOTE: If you do not have an electronic signature configured, print the Medication Review
Report, have both the patient and the pharmacist sign the report, and scan it back into the
system.

9. Have the patient sign his or her name on the electronic signature tablet. Click the OK button
on the signature tablet.

The patient signature appears once the patient signs on the electronic signature tablet.

12
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10. Have the pharmacist sign the electronic signature tablet.

11. When you are finished, tap Done on the signature tablet.

Printing a Medication Review

12. A prompt will appear asking if you want to print a paper copy of the electronic Medication
Review. Click Yes.

13. The Medication Review report print form will appear. Select the appropriate print options
and click Print and provide this copy to the patient.

Billing a Medication Review

14. Once printing is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

NOTE: If the user account of the pharmacist logged into the terminal during the processing
of the Medication Review includes a license number that is identical to the license number of
a Prescriber card in the Doctor file, then the Prescriber field on the F12 screen for the claim
will be populated with that prescriber.

13
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15. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

File Edit Rx View Labels Profile Reports Utilities Central Fill Cards Session Help
l F3 - Patient “ F5 - Drug “ F7 - Doctor ‘ F9 - Workflow F11 - Drop-off I F12 - Fill Rx I Alt-X - Start ‘
First Fill Last Fill Information
0/ NewRx | Pending Adj 050814 || 0 0 Qty 50.00 Init
Priority Default Wait Time ﬂ Due in 19 mins Forward Rx (Fz| Work Order 11 @ Delivery Pickup j
Patient Search Drug Search Pack J Doc Search Loc Office j
Mame | Doe, Jane Age34  |Brand Mame  Dr. Test, Doc
Address | 100 Main St Female | | Generic Address
City 5t. John's Prov |NL Pack Form Sched City Prov ON
Phone |Cell (555) 555-5555 Purch OnHand |0 MNoimage ||Phone |(555) 555-5555
Plan  |VET ClientID |11111 DIM Min Qty |0 Lic# 123 Alt, Lic#|321
Allergies Sig Prescription Drug Program Tnit KRL  KRL Auth Qty g
PRESCRIPTION DRUG PROGRAM Disp Qty Refills(+) Rem Qty 0
G.P. % 0
Days 1
. Acq Cost
Conditions Prod Sel 3- Pharmcj Cost $0.00
Coute of Adm E oW writen | yie 5000
oute of Admin Labels 1 Fee SO
Frzgalem El Total 50.00

Medication Review Options

Several Medication Review options are available from the right navigation pane on the

Medication Review Annual Review screen.

File Edit Med Review View Profile Utilities Central Fill Cards Session Help

Prescription Drug Program

Patient | Test, Pat Address
Birth | 01/01/1955 | 59 years Male Plan | AHE ClientID | 123
Allergies Conditions

F3 - Patient F5 - Drug F7 - Doctor Fa - Workflow Fi1 -

Reviewed With | Test, Pat (In Person)

F12 - New R: Alt-X - Start

Review
Print Medication Review
Select Rxs for review

Phone View Eollow Ups

View
Patient Charting
Patient Documents

Patient Med Reviews (8)

Questions | pMedical History | Mon-Prescription Medications | Rxs From Other Pharmacies | Pharmacist Activities | General Commer * | *

Physical Activity <Mot Answered> j
Smoking <Mot Answered> j

Consent Given =Mot Answered> j

Profile
AR
Alcohol Intake <Not Answered: j Active Rus

Active Rxs w/Passtimes
Pricing Profile
Mot Disp/OTC Profile

14
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Review
Print Medication Review
When this option is selected, the Medication Review report screen will appear, allowing you to

set various print options. Configure the appropriate print options. Select Preview to view the
report or Close to exit.

-
= Medication Review Report (Prescription Drug Program, 2014-Aug-05) |E| | = e ]
File

Options

[_| Print store lago

Pharmacist:
Kroll |

Extra Lines
Allergies 0

Conditions 0

@y @y @y

Dirugs 0

Printer Microsoft XPS Document Writer j Copies 1

Tray  Automatically Select j [¥] collate [ Duplex

IBestDre Defaulta] I ' Erint ] l Preview J l x CloseJ

Select Rxs for review

If you wish to add/edit Rxs on the Medical History tab, click the button Select Rxs for review.
When selected, the Medication Review Rx Selection screen will appear, allowing you to add
and remove items from the Medical History tab on the Medication Review Annual Review
screen. Click OK to save any changes and Cancel to close the screen.

15



%KROLL

g Medication Reviews - Newfoundland and Labrador
omputer Systems Inc

«* Medication Review Rx Selection ®» @Bl B P
Pre-Selected (3) | Other Rxs | nfills | Not Dispensed | Discontinued
Rx Num Drug Fill Date
¥} 1000962 Synthroid 112mcg 14-Jul-2014
v} 1000961 Prinivil 2.5mg 14-Jul-2014
V| 1000960 Amoxicillin 50/ml 14-Jul-2014
Select All | | Select None J
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default L]
 OK [ % Cancelj

View Follow Ups

When this option is selected, the Medication Review Follow-ups screen will appear, allowing
you to create follow-up reviews for the patient.

NOTE: This is something that you initiate to follow up with the patient after the Medication
Review has been completed. This is NOT a Medication Review Followup review.

«f Medication Review Follow-ups l P | E H =AACE X
Medication Review Brint Report
Type  Prescription Drug Program Completed On
Patient Test, Pat Completed By

Follow-ups (0) [F2] (Tng) (0=)

Due Date | Reason Brand Name FuMurn |Resolved | o

m

To add a follow-up, click Ins and complete the Medication Review Follow-up screen. When you
are finished, click Save.

16
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wf Medication Review Follow-Up l LB Jl =NACE X
Medication Review
Type  Prescription Drug Program Completed On
Patient Test, Pat Completed By

) Do not follow up

19! Follow up required in days =

Reason Unknown j
Comment
[ Resalved on by
Comment

[  save ] ’ X cancel ]

View
Patient Charting

When this option is selected, the Patient Charting form will appear, displaying information
about the patient’s weight, height, blood pressure, blood sugar, and so on.

« Patient Charting EBllo= P9
Weight | Height | Blood Pressure | Blood Sugar | Cholesterol [ Creatinine CL { INR { Clozaril GI<UE]
o Weight Values (3) [F2][Ins)(Del)
20 : | _|pete|weight .
] e j2013 65
= : : _ _ 1m0z 60

210 A ;i A : . L. 0B/01/2011 58

i
o
m

OlJantl OMarfl 0agh Ol OfSeptl OOl Olanl2 OWANEZ 0IMayi2 OlUllZ 01Sepl2 OlkoviZ Ollani3

X o

Use the F2, Ins, and Del buttons to modify, insert, or delete information on this screen. Click
Print to print or Cancel to close the screen.

17
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Patient Documents

When this option is selected, the Patient Document List will appear displaying a list of
documents associated with the patient.

[E] =

Patient Document List

" 3% IAddﬂewDDcumem ¥ |

Documents (1] [F2)[Ins) (Del)

Title Init  |Document Type| Created ¥ |Retain Until | -
Prescription Drug Program P Med Rewview 11072014

Use the F2, Ins, and Del buttons to modify, insert, or delete a patient document. Click Close to
exit the screen.

Patient Medication Reviews

When this option is selected the Patient Medication Reviews and Dialogs screen will appear,
displaying a history of all reviews for the patient including any that are currently in the
Medication Review queue.

¢ Patient Medication Reviews and Dialogs l W B = | B S

P - Print/Reprint

F2 - View Details

Medication Reviews [2]
Tupe Status Fee Status Created ¥ | Completed -

Prescription Drug Program Pending Review Not Completed Yet 05/08/2014 N
Prescription Drug Program Pending Review Mot Completed Vet 05/08/2014 ‘ ‘

Double-click a Medication Review to view its details. Click Close to exit the screen.

Profile

The Profile menu on the Medication Review Annual Review screen is identical to the Profile
menu on the patient profile. This menu allows you to view All Rxs, Active Rxs, Active Rxs w/
Passtimes, Pricing Profile, and Not Disp/OTC Profile.
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Completing Medication Review ‘Saved for Later’

1. To call up Medication Reviews ‘saved for later’ or added to the Med Review Queue via auto
prompting, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

The Medication Reviews queue will appear. Select the Medication Review record you want
to complete and click F - Call Up.

b)

File Edit Patient Profile Reports Utilities  Central Fill Cards  Session  Help
F3 - Patient F5 - Drug F7 - Doctor l F9 - Workflow

Last Mame Doe First Name Jane

F11 - Drop-off “ F12 - New Rx “ Alt-X - Start ‘

saltation Ms. | oK Save % Cancel | | Patient

Profile
N - New Review/Dialog P - Print/Reprint

All Rxs
F2 - View Details D - Pharmacist Declined R - Patient Refused 5
Medication Reviews (4] Active Ris
Type | Status | Fee Status Created ¥ | Completed | | Active Rxs w/Passtimes
Prescription Drug Program Pending Review Not Completed Yet 05/08/2014 Refillable Rxs
Prescription Drug Program Completed Electronic Pending Claim 05/08/2014 | 05/08/2014
Prescription Drug Program Pending Review Mot Completed Yet 05/08/2014 L Pricing Profile
Prescription Drug Program Pending Review Not Completed Yet 05/08/2014 i Mot Disp./OTC Rxs

F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the

right navigation pane.

The Medication Review queue will appear. Select the Medication Review you want to
complete and click F - Call Up.

b)

File Edit Utilities MNH Workflow Cards Session Help

I F3 - Patient F5 - Drug F7 - Doctor ‘ F Workflow F11 - Drop-off F12 - New R Alt-X - Start

. . . - Pri i IE m o Workflow Actions
Medication Reviews 5 intmerrnt [ -caben e
D - Pharmacist Declined R -P. Refused space - Mark Rxs Rx's Te Do
Patient | Type | status | Fee status | created | Completed| » | Rx'sIn Progress
Dukes, George Presaiption Diug Program Pending Review Not Completed Yet 15/08/2014 Pending Adjudication ()
Dukes, George Prescription Drug Program Pending Review Not Completed Yet | 07/08/2014
Dukes George Prescrintion Druag Proaram Comnleted Flectronic  Pending Claim 07/03/2014 07 0&/2014 Trouble (0)

2. Complete steps 3-8 of the Creating an Electronic Medication Review section.
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Sample Electronic Medication Review Report

Newﬁllj‘i;dland

Prescription Drug Program

NLFDP # Labrador
Personal MedicalionRecordor
Doe, Jane
DOB Gender  |NLPDP FamilyDoctor
01-Jan-1980 F
Alcohollake Physical AChvity Smoking ConsentGIven
Ona [Jwoderate [JHeaw | Jnia [Imoderate [ JHeaw |[INo [JPast [ves |[_]ByPatient []ByRepresentative, Name:

DrugHame Dosagénstructions Reasonforlze Comments/Speclalstructions
642Tablets TAKE 1 TABLET ONCE DALLY
TypeDiabetes Disgnosed Does the patientcheck his/her blood sugar on aregular basis?

[11.Age Diagnosed: [ ]2 AgeDiagnosed: |[ | Mo [ ] Yes, Interval:

Whatwas the Patient's lastknown:

EloCOGIUCOEE. ‘ BloodFressure. RBATC: LDL-C- TC/HDL-C.
FPharmacisthotesT ionsre:Diab oritoring:

In Addition to preparingthe Best Possible Medication List and discussing the patients monitoring oftheir diabetes the pharmacist also performed the following activities

Performed /reviewed blood glucose monitortraining including the properdisposal oftesting supplies Yes | Mo
Discussedthe importance of preventative strategies such as properfoot care andregular exams Yes | No
Discussedthe potential eventual needto addinsulin therapy, if appropriate Yes | No
Discussedthe importance of monitoring glucose levels - both daily as well as quarterly A1Ctesting, ifapplicable Yes | No
Referred patienttowww.diabetes.ca or provided additional educational services Yes | No
Discussedthe benefits of healthy eating and reqular physical activity Yes | No

ACOONEACTVIES.

Mewfoundland andLabrador Prescription DrugProgram
B070, Postal Steton A% 51 Joavs, NL Canaca ATE 488
5 P 708 TIE I

Page 1 of 2
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Prescription Drug Program

Date Prepared

Mewfoundland andLabrador Prescription DrugProgram
P.O. BOX 5070, Postal Staflon ‘A", St Jonm's. NL. Canada  A1B 4A6
T. T09.739.3615 F. 7097392909

] \ [ -
Mg, | oM sam | Nttt '
Patient (or Representative) Signature Krol
Page 2 of 2
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A

Viewing a Completed Medication Review

With Electronic Signatures Enabled
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient FS - Drug F7 - Doctor F9 - Workflow \ F11 - Drop-off “ F12 - New Rx “ Alt-X - Start ]
Last Name Test First Name Pat Salutation j _ Save
N - New Review/Dialog P - Print/Reprint F - Claim Fee C - Cancel Claim
F2 - View Details D - Pharmacist Declined R - Patient Refus ed
Medication Reviews [7) [FZ][Ins) [Del]
Type | Status | Fee Status ICreated ¥ |Comnleted | -
Prescription Drug Program Pending Review Not Completed Yet 30,/07/2014
Prescription Drug Program Refused by Patient Mo Fee Applicable 30,07/2014 30,/07/2014
Prescription Drug Program Declined by Pharmacist No Fee Applicable 30/07/2014 30,07/2014
Prescription Drug Program Completed Electronic Pending Claim 30,07,2014 | 30,/07,/2014
Prescription Drug Program Completed Electronic No Fee Applicable 30,/07/2014 30,/07/2014
Prescription Drug Program Declined by Pharmacist No Fee Applicable 30,/07/2014 30,/07/2014 E
Prescription Drug Program Declined by Pharmacist Mo Fee Applicable 30/07,/2014 |30/07,/2014

4. The Medication Review View screen will appear. Click the various tabs to see the
Medication Review information that has been entered.

Completed | 05-Aug-2014 04:40 PM | 8secs

Medication Review View [_JE [é]
Prescription Drug Program
Created 05-Aug-2014 04:40 PM | Status Completed Electronic Fee Status | Pending Claim Fee Rx N/A
Started | 05-Aug-2014 04:40PM | Duration  ReviewedBy | Kroll View Signatures

Reviewed With | Doe, Jane (In Person)

Medical History |Genera| Comments | Pharmacist Commentsl Questions | Pharmacist Activities | Non-Prescription Medications | It

Patient Medical History

Currently Taking 30 TAB 642 Tablets 65mg [PPI]
Dr. Test, Doc
Last Fill Date: 05-Aug-2014, Days Supply: 30
TAKE 1 TABLET ONCE DAILY

Indications

Comments

5. Click Print to print the Medication Review, or View Signatures to view the pharmacist’s or

patient’s electronic signature.
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Scanned Reviews with Manual Signatures
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

4. The Medication Review View screen will appear. The Review tab displays information

entered on-screen during the Medication Review; the Documents tab displays the scanned
image of the signed Medication Review. Scanned paper Medication Reviews is also viewable

from Patient Documents.

Medication Review View - - s P
Prescription Drug Program
Created 05-Aug-2014 04:40 PM Status | Completed Electronic Fee Status | Pending Claim Fee Rx N/A

I| Review Dccumentsl
Started 30-Jul-2014 02:25 PM Completed | 30-Jul-2014 02:26 PM Duration 1mOs t Print
Reviewed By ' Scott Belfer Reviewed With ' Belfer, Scott (In Person)

Questions | Medical History ] Non-Prescription Medications | Rxs From Other Pharmacies l General Comments i Pharmacist Comments

-

Alcohol Intake <Not Answered> v |

Physical Activity <Not Answered> L]

Smoking <Not Answered> v I

5. Click Print to print the Medication Review.
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Paper Medication Reviews

This section explains how to perform paper Medication Reviews. Paper Medication Reviews
must be completed on paper, signed, and scanned back into the system.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring the Medication Review Prompt

The system prompts for Medication Review when the option Prompt for Medication Review is
enabled under File > Configuration > Store > Rx > Prompting.

f ¢ Store Level Configuration Parameters |E,| LJ& ]
| ﬁenerall Ealientl Drug | Dgctor| B | FDBE | gdiudicationl I:abelsl Heporﬁsl ﬁecurityl lnterfacesl Drdgrl E-AHI ¥ -Tao Do| [Ectrl E

1- Generall 2-Pricing 3+ Prompting| 4 - Murzing Homel 5 - Background Rx FiIIingI B -Workflowl i- Eounselingl 8- EeHH|
Diug Programs

Prampt to use Drug Subs (7] Automaticaly use Drug Subs [] Participate it the: Fix Canada # Health Inform Program

Usze Drug Subs when Batching

Prompt If Doctor Refused Repeat when Cancelling Rx [ Participate in the Pharmacy Access program

Prompt for Comments when Canceling an Rx [] Use Station Mame Subdirectories For Pharmacy Access
[ Ahways require comment Days Back: 365

[ Prompt for Comments when Inactivating an Rx [] Enable Rx Canada Frogram [RxGateway)

[ Ahways require comment

[T Prampt far Patient Counseling on new R . . i . .
7] Prompt to Bateh NH Fies [] Prompt to Enral Patients in Refill Reminder or Auta Refil Program
H ) . , . Prompt to Exrol MH Patisnts in Refil Reminder or Suto Refill Program
Erompt ;“'heg riok dlsc:;sm%as ;Irug ¥ PF‘?Ck Size Prompt to Enable Ries for Fefill Reminder and Auta R efil Program
rompt For Fepeats er.1 opying an ik . Enrol Patients for Pickup Motification Ho j
Prompt Ta Use Manual Price From Last Refil

Services

[] Remave Manual Price for Batched Fixs Enrol WH Patierts for Fickup Notifization No j

[T Prampt if D octar Autharization Received for Marcatic Res

[] Check far High Intensity Drugs Prampt to copy workflow packaged info for cancel and refill Rxs
Prompt if there is not enough inventory to fill the Rx Frompt to copy ta new number if refilling an By with no repeats

[] Prevent Copying an Inactive R+ ta a Mew Mumber [ Prampt for Due Date on autafil batches

[T] Shaw local patient prafile o fill [ Prampt for Tx comment on autofil batches

Prampt to Copy "Mistake” Fixs to @ New Mumber Save Route code from Ry as default value if no default is zet Ask j

[ Show thermal/dat matrix label config on autafil
Save Form code from Rix as default value if no default iz set Ack j

[ Prompt to Print Scrpt Image for 13t Fil of an Unfiled Rx

[ Prompt for &4DL Plan Information if Sé number is NOT set Prompt for Medication Review
rack Medication Review Hejection Reason:

Allows Mever Prompt' Far Medication Review

[ Prompt if was Undeliverable when Cancelling an Rix

Search " OK
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When the option ‘Prompt for Medication Review’ is enabled, the system screens each patient
for Medication Review eligibility every time an Rx is processed. If the patient is eligible, the user
is prompted and presented with a number of options as shown below.

& Select an Option =4 P

This patient may be eligible for the Prescription Drug Program.

[ Print Report Now J
( print Report Later ]
[ 1 have Other Rxs to fill for this patient l
[ Do not prompt me until the next time the patient comes in. ]

l Do not prompt until ... ‘

| Never Prompt for this patient |

e Print Report Now: This will call up the Medication Review report so you can select the
items you would like to print on the report.

e Print Report Later: This places a record in the Medication Review queue allowing you to
print the Medication Review at a later date or time. See section ‘Completing MedsCheck
‘Saved for Later’ for further details.

o | have Other Rxs to fill for this patient: This will allow you to continue filling more Rxs
for the patient before printing the report.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

e Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.
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Creating a Paper Medication Review (Manual)

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor FO - Workflow F11 - Drop-off I F12 - Return to Rx “ Alt-X - Start ]

Last Name boe First Name Jane Salutation Ms. j _[ ' Rx ” X scan ] Bahent
Profil
Address1 100 Main St Phone Numbers (1) (00  githdate 01/01/1980 i
Description |Ph0ne All Rxs
Address 2 Age 34 years
J J Cell (555) 555-5555 J Active Rxs
City St. John's v | Prov ML Gender Female - i i
Neo BeERgalble Active Rxs w/Passtimes
Postal M1M 1M Country Canada j Llanguage English j
Refillable Rxs
Email Family Doctor Height .. .
Pricing Profile
Quick Code Weight Load [ Delete | Not Disn/OTC Re
ot Disp./ 5
Comments (0) [F2] (Tns|(De1)
. EEE j Rxs Filled in Error
Topic Comment
Plans (1) Suspended Rxs
| subPlan Code| Group ID | Client 1D |[Bpiy | -
1 VET 11111 Perform FDB Analysis
View
Alternate Addresses
k = Batch
Allergies (0) General l Family l COPEYEI Commgnicationsl Other l [Ectrl B stenes
- Charting
Patient Consent
Active Consent Unknown Consent
: Credit Cards
A |
nimal - [ Unit Dose o "
Deceased On Type <Mone> j ocuments
Medical Conditions (0) Ins| — Medication Review/Dialogs (4)
Prescriptions Cycle <Mones - _
Delivery Type  Default (Pickup) ~|  piceGionn  cDefane (<honest =l Rx Counseling History

3. The Medication Review queue will appear. Click N — New Review/Dialog.

& Patient - Helvey, Ricky T B = = K

File Edit Patient Profile Reports Utilities MH Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor F9 - Workflow F10 - Pickup " F11 - Drop-off ” F12 - New Rx " Alt-X - Start

Last Name Helvey First Name Ricky Salutation j _ Save Gatent
Profile
N - New Review/Dialog

All Rxs
Medication Reviews (0] o Active Rxs
Tupe Statusz Fee Status Created ¥ | Completed || Active Rxs w/Passtimes
‘ ‘ Refillable Focs
Deicing Deafil

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown
menu and click Print Now. If you wish to add to the Med Review queue in order to print the
Medication Review later, click Save for Later.

Medication Review/Dialo =y
g

Type Prescription Drug Program j

I Print Mow 1 lga\reforlaterl l X cancel l
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5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the
Rxs you want included in the report. When you are finished, click OK.

¥ Medication Review Rx Selection e =B8] =
Pre-Selected (3) | Other Rxs | Unfills | Mot Dispensed | Discontinued
Rx Mum Drug Fill Date
1000958 Amoxicillin 50/ml 11-Jul-2014
1000957 Prinivil 2.5mg 11-Jul-2014
1000956 Synthroid 112meg 11-Jul-2014
Select all ] [ Select None ]
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default j
7ok

6. The Medication Review Report form will appear. Select the appropriate print options and
click Print. The report will generate.

Complete the Medication Review on the form. Sign the Medication Review Report and
have the patient do the same.
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Scanning Medication Review Reports

8. From the Alt-X Start screen, go to Utilities > Printed Document Scan/Import.

File Edit Reports [Utilities | Central Fill Cards Session

Help Version 10

F3 - Patient [

Last Rx Numbers

1000
9000
Modify R

Reprint R

Cancel Ry

Modify Specifi
Reprint Specifi
Counsel R

Drug Ordering
Merge

Unmerge

Adjust Current Wait Time
Check Interactions
Quick Price

Delivery Orders

View Mail/Messages

View Packager Batches

View Pending Metwork Queue
Labels

Script Reentry Mode

Credit Card Password Manager
Database Maintenance

Drug

Patient/Rx Import

Y }kﬂow " F11 - Drop-off " F12 - New Rx “ Alt-X - Start ]
3

Alt+=

Followups

0-1hrs  1-4 hrs 4+ hrs  Tomarrow  Trouble Total
0 0 0 0 0 4 R Counts
Mew Rxs 0
0 0 0 0 0 4 Repeat Rxs 0
3
Total Rxs 0

Printed Document Scan/Import

9. The Import Scanned Documents screen will appear. Place the report pages face down on
the scanner hopper. Check Scan both sides of paper if you are scanning pages with
information on both sides and your scanner supports dual side scanning. Click Start

Scanning.

7
Import Scanned Documents

B~

Scanner
Scanner
Mode

Resolution 100

FUJITSU fi-6130dj
Colour

IScan bath sides of paper [[] I

Document Processing
To Process 0

To Reconcile @

Wiew Scan History

[ Process and Reconcile ]

28



% KROLL Medication Reviews - Newfoundland and Labrador

Computer Systems Inc.

10. When scanning is complete, the screen will indicate how many pages were scanned
successfully and how many will need to be manually reconciled. When you are finished,
click Process and Reconcile.

Import Scanned Documents =SS

Scanner

Scanner  FUJITSU fi-6130Zdj #2
Mode Colour

Resolution 100 Scan both sides of paper [

Document Processing

To Process 0 I Process and Reconcile I
To Reconcile 0

[‘u’iew Scan History] l X Close l

11. The Document Scan Reconciliation screen will appear. Items ready to be processed will
appear in the Documents to be created section. Items that need to be reconciled will
appear in the Unprocessed Images section.

wf Document Scan Reconciliation ® Ble @ XS
Documents to be created (1)
Scanned on Status Filed By Type Title Patient RxNum |Pages| Message -
11/07/2014 12:31:43 | Read
Process
= | Pending
Documents
B F|zoms00 QO DBEH S S Unprocessed Images (0)| Current Document
» | Document Images [2) (Dall [~ 41[~4)
Scanned On{ Type | Info Message -
T — K 1231:43 | Patient Med Revie 1
Nesformdlard 1231:45  Patiert Med Revie 2
»gor ¢ ador
TR
¥ e e T L_ - e |
'y ipacn sy ey Casrtior E
Ll Utdesk L=z bt Lthduas _Hone _le L2, L% B 22 1 LB Sovmrr s M
—— p— p— p—
e |".-l LR LD |
P Cod 0o b s 4 R T TR EURE L e e LT T A
[ 20 agrsane ., 5 bUBgNEIET ‘:lr: o RN
e atas Tl mierTs iy e vy
il |M'!ubr A (= oL S
- =
IBAJCOCIE £'4 NEADGITG LA D11 648 54 LAl 3CI0CTL 1I3"E S50 AEITHENURITA ¥ 5F D3 T W X300, B4 SOHT CEHE S TITHIN BT OV 3 B
ke Al o gt Pt AngT [ N R T ]
AP I S St el W A DR AR G R T
W i oo e ver | i »r
TEXT m W VT B AT T B e i o
T I o U LB ST LR dal el sl b e | o Document Type patient Med Review j
T AT EOTEND I W MY EEP 00 T IIH B CISE 3N Vs | &
Patient [ F3 ]
by e et ﬁ Name Doe, Jane DOB 24/10/1950
Fom Address 100 Main St
City, Prov St. John's, NL
Med Review
11/07/2014 - Prescription Drug Program (Printed Paper) j
Brightness Contrast Saturabton
0 0 0 X cancel| | ' Next ]
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12. If all Rxs were scanned successfully and appear in the Documents to be created section,
click the Process Pending Documents button. Click Cancel to close the screen.

Billing a Medication Review

13. Once scanning is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

14. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

Completing Medication Review ‘Saved for Later’

1. To call up Medication Reviews ‘saved for later’, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

b) The Medication Reviews queue will appear. Select the Medication Review record you want
to complete and click F - Call Up.

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient | FE 19 F7 - Doctor [ F9 - Workflow “ F10 - Pickup F11 - Drop-off ” F12 - New Rx H Alt-X - Start

Last Name Helvey First Name Ricky Salutation j ok — X Scan ] Patient

o ; Profile
N - New Review/Dialog P - Print/Reprint ~ancel Clai A B
F2 - View Details D - Pharmacist Declined R - Patient Refused Active Re
Medication Reviews (1) (72) (ins) (a1 ctive Rus
Type |Slab.ls |Fee8tatus Cieated ¥ IComp\eted I + || Active Rxs w/Passtimes
Prescription Drug Program Pending Review Not Completed Yet 06/08/2014 Refillable Rxs

Pricing Profile

F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the
right navigation pane.

b) The Medication Review queue will appear. Select the Medication Review you want to
complete and click F - Call Up.

File Edit Utilities NH Workflow Cards Session Help

’ F3-Patient || F5-Drug | F7 - Doctor ‘ F9 - Workf F11 - Drop-off [ Fi2-N ‘ Alt-X - Start
. . . P - Print/Reprint ‘ u Refresh Workflow Actions
Medication Reviews ist Decli ; —_— = re
D - Pharmacist Declined R - Patient Refused  space - Mark Rxs Rx's To Do

Patient | Type | status | Fee status |Created | Completed | » | Rx'sIn Progress

Dukes, George Prescnpﬁon Drug Program Pending Review Not Completed Yet 15/08/2014 Pending Adjudication (0)
Dukes, George Prescription Drug Program Pending Review Not Completed Yet 07/08/2014

Dukes, George Prescription Drug Program Completed Electronic  Pending Claim 07/08/2014 07/08/2014 Trouble (0)

Dukes, George Prescription Drug Program Completed Electronic  Pending Claim 07/08/2014 07/08/2014 Rx Counseling (2)
Dukes, George Prescription Drug Program Pending Review Not Completed Yet 07/08/2014 — 2
Dukes, George Prescription Drug Program Printed Paper Review Not Completed Yet 06/08/2014 Medication Reviews (9)
Dukes, George Prescription Drug Program Completed Electronic  Pending Claim 06/08/2014 06/08/2014
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2. Complete steps 4-14 of the Creating a Paper Medication Review section.

Sample Paper Medication Review Report

Prescription Drug Program

Newﬁniﬁdland

NLPDP # Labrador
Personal Medicalion Recordor
Doe, Jane
DoB Gender | NLPDP FamilyDoctor
01-Jan-1980 F

Alcohollntake Physical Achvity SmoKing ConsentGiven
|:| MIA D Moderate |:| Heavy I:‘ NI I:‘Maderate |:| Heavy |:| Mo |:| Past |:| Yes |:| By Patient |:| By Representative, Mame:

DrugName Dosagenstructions Reasonforlse Comments/Specialstructions

642 Tablets TAKE 1 TABLET ONCE DAILY

TypeDiabetes Diagnosed
[11,Age Diagnosed: [ ]2, AgeDiagnosed:

Does the patient check histher blood sugar on aregular basis?

CIno [ ves, interval:

‘Whatwas the Patient's last known:

Bloo0GIUCoSE: BloodFressure. HBATC: LDOL-C TCRDL-C:
Pharmacisthote s/ tionsre:DiabetesMonitoring:

In Addition to preparing the Best Possible Medication List and discussing the patient's monitoring oftheir diabetes, the pharmacist also performedthe following activities

Performed /reviewed blood glucose monitortraining includingthe properdisposal oftesting supplies Yes | No
Discussedthe importance of preventative strategies such as properfoot care and regularexams Yes | No
Discussedthe potential eventual needto add insulintherapy, if appropriate Yes | No
Discussedthe importance of monitoring glucose levels - both daily as well as quarterly A1Ctesting, ifapplicable Yes | No
Referred patienttowww.diabetes.ca or provided additional educational services Yes | No
Discussedthe benefits ofhealthy eating and regular physical activity Yes | No

AOOMONG R CIVINES.

Newfoundland andL abrador Prescription DrugProgram
PO BOX 3070 Postal St3ton AT St Johs. WL Canads A1S LA
T. 7875 F. 787320

Page 1 of 2
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Prescription Drug Program

Date Prepared Patient (or Representative) Signature Krell

Newfoundland andLabraderPrescription DrugProgram
P.O. BOX 3070, Postal Station A, 5t Johm's, NL, Canada  A1E 4A6
T. TO8.TIIENS o797

Page 2 of 2
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Viewing a Completed Medication Review

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

4. The Medication Review View screen will display the scanned image of the completed
Medication Review. Scanned Medication Reviews are also viewable from Patient

Documents.

=
Medication Review View

B3| ===

Prescription Drug

Created 06-Aug-2014 09:24 AM Status | Printed Paper

Program

Fee Status | Review Not Completed Yet Fee Rx N/A

Prescription Drug Program

h]ewfm J?Idland
Labrador

M_PDP £
Peseons! Viscliation Rscar o
Doe, Jane
Cowr | WLFDP Farh Dokr
01-Jan- 1980 F
“Aicohal Ak Fhysical Aziviy Erickng [ Consen: Eien
[T [Twvoderste [ THzaw |[Twn [ Msdorate [ Thcave |0 [Trast [vee |[Taviavert [ by Heorecomtzive Hame

Ty Moo

642 Tablate

PusAye inslclions Freeescm fon Dlsae

TAKE L TABLET ORICE DALY

CowmnenlsSpesia T

e Cibetes Digrosed

Tioee Mz pllEnt Check Fimer B0 SLger O & reguiar basis?

[[]1, age Cizgrosea.  [] 2 Ace Diagnosed:

[Jnz [ ves, intanval:

Whial was Be Palienls las| known,

Dlocd Glucess: Dload Fessue: TEATG

| Lo

TCAIDLL:

PRSI0 st NS L RECOMIEnaahong e, (heDefes Loy
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Declined and Refused Medication Reviews

This section explains the process for recording Medication Reviews that have been declined by
the pharmacist or refused by the patient.

NOTE: The medication review records that are declined by the pharmacist or patient refused
can also be noted from the Medication Review queue on the F9-Workflow screen.

Pharmacist Declined
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate Medication Review and click D — Pharmacist Declined.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor | F9 - Workflow ” F11 - Drop-off ” F12 - New Rx ” Alt-X - Start |
Last Name Doe First Name Jane Salutation Ms. j oK Save XK scan
N - New Review/Dialog P - Print/Reprint
F2- View Details D - Pharmacist Declined R - Patient Refused
Medication Reviews [7] [[F2] (Tns] [Del)
Type |Status |Fee Statuz Created ¥ | Completed | -
Prescription Drug Program Printed Paper Review Mot Completed Yet 06/06/2014
Prescription Drrug Program Pending Review Mot Completed Yet 06,/05,/2014

4. Select the appropriate option from the Decline/Refuse prompt.

[ = Select an Option |EJ e 23|

Decline/Refuse - Prescription Drug Program.

| Do not prompt until the next time the patient comes in. |

| Do not prompt until ... |

| Never Prompt for this patient |

| Cancel |

e If you select Do not prompt until the next time the patient comes in, no further action
is required until the next time the patient visits the pharmacy.

e If you select Do not prompt until... you will be prompted to specify the next time you
want to be prompted for the patient’s Medication Review. Complete the form and click
OK.

e [f you select Never Prompt for this patient you will not receive any additional
Medication Review prompts for the patient.
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Patient Refused

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate Medication Review and click R — Patient Refused.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F11 - Drop-off “ F12 - Mew Rx “ Alt-X - Start I

F3 - Patient F5 - Drug F7 - Doctor l Fo - Workflow

Last Mame Doe First Mame Jane Salutation Ms. j

oK Save X scan

Prescription Drug Program Pending

N - New Review/Dialog P - Print/Reprint
F2 - View Details D - Pharmacist Declined
Medication Reviews [7] [FZ] [Tng) (Del]
Type | Statuzs |Fee Statuzs |Ereated T | Completed | -
Prescription Drug Program Printed Paper Review Mot Completed Yet 06/08/2014

Review Mot Completed Vet 06,/08/2014

4. Select the appropriate option from the Decline/Refuse prompt.

[E3| =5

w* Select an Option

Decline/Refuse - Prescription Drug Program.

I Do not prompt until the next time the patient comes in. ‘

I Do not prompt until ... ‘

I Never Prompt for this patient ‘

I Cancel ‘

e If you select Do not prompt until the next time the patient comes in you will be
prompted to specify if the review was declined by the Patient or Someone Else.

o If you select Someone Else, the Medication Review/Dialog Refusal form will
appear. Click the lookup button next to the Select agent field to search for the
patient who refused the review. Select a relationship from the Relationship to
patient menu and click OK.

¢ Medication Review/Dialog Refusal

=8

Refused By _) Patient @ Someone Else
Select agent Doe, Jane

Last name Doe

Eirst name Jane

=
;

Relationship to patient @

| «ox | IXCanceI‘

o No further action is required until the next time the patient visits the pharmacy.
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e [f you select Do not prompt until... you will be prompted to specify the next time you
want to be prompted for the patient’s Medication Review. Complete the form and click
OK.

e If you select Never Prompt for this patient you will not receive any additional
Medication Review prompts for the patient.

NOTE: Medication Review records that have been declined or refused cannot be deleted
from the Medication Reviews queue.

Medication Review Statuses

This section explains the statuses that appear in the Medication Review queue at various
stages throughout the Medication Review process.

Statuses

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Docto | F9 - Workflow F11 - Drop-off F12 - New Rx | Alt-X - Start l

LastName Doe First Name Jane sautation s, ~|  [NNOKINN ve l X Cancel l Patient
= Profile
N - New Review/Dialog P - Print/Reprint F - Call up Al Rxs
F2 - View Details D - Pharmacist Declined R - Patient Refused Active R
Medication Reviews [5) (F2)[Tng)(al) €TV
Type Status ]FeeSlaus |Created ¥ |Completed | 4 Active Rxs w/Passtimes
Prescription Drug Program Pending Review Mot Completed Yet 19/08/2014 Refillable Rxs

Prescription Drug Program Printed Faper Review Not Completed Yet 31/07/2014 o :
Prescription Drug Program Completed Electronic Pending Claim 06/08/2014 06/08/2014 =] ||| Pricing Profile
Prescription Drug Program Declined by Pharmacist Mo Fee Applicable 11/07/2014 11/07/2014 Mot Disp./OTC Rus

Prescription Drug Program Refused by Patient Mo Fee Applicable 1908/2014 19/08/2014

Rxs Filled in Error

Pending
Reviews that have been initiated but have not yet been completed.

Printed Paper
Reviews that have been printed but have not yet been billed.

Completed
Reviews that have been printed and billed.

Declined by Pharmacist
Reviews that have been declined by the pharmacist.

Refused by Patient
Reviews that have been refused by the patient.
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Fee Statuses

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor Fa - Workflow F11 - Drop-off “ F12 - New Rx " Alt-X - Start

Last Name Doe First Name Jane Salutation Ms. j | oK | 3 X cancel Patient
o - ) o - ~ ¥ Profile

N - New Review/Dialog P - Print/Reprint F - Call up ancel Clain All Res

F2 - View Details D - Pharmacist Declined R - Patient Refused Active Roc

- - B T Vi

Medication Reviews (3) oo V™

Type [Status Fee Status Created ¥ |Completed | + | Active Rxs w/Passtimes

Prescription Drug Program Pending Review Not Completed Yet 19/08/2014 Refillable Rxs

Prescription Drug Program Refused by Patient No Fee Applicable 19/08/2014 19/08/2014 — -

Prescription Drug Program Completed Electronic Pending Claim 06/08/2014 06/08/2014 =f|l| Pricing Profile

Review Not Completed Yet
Reviews that have been initiated but have not yet been completed.

No Fee Applicable
Reviews with no associated fees (usually declined or refused reviews).

Pending Claim

Electronic reviews: Completed reviews with a Status of Completed.

Paper reviews: Reviews that have been printed and the option Require Document scan to
complete Paper Med Review is off, and reports that have been printed and scanned back into
the system if this option is enabled.
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